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Editor’s Letter 

 
Thanks to Robert William Harrison for contributing the Family Group sheets and Pedigree 

Charts on our 23rd President, Benjamin Harrison and his grandfather, the ninth President, Wil-

liam Henry Harrison.  The line continues to Richard Harrison born about 1595 who had at least  

2 sons, Benjamin and Thomas, born about 1619 at Kingston upon Hull, Yorkshire England.  

Robert William Harrison descends from Thomas Harrison.  For more information on Robert 

William Harrison see TREE TALK Volume 24, Issue 3, Spring 1999. 

 

Thanks to Genealogy Gems:  News from the fort Wayne Library #85, March 31, 2011 for per-

mission to reprint “Remembering Margins” by Kay Spears. 

 

Our member, Mary Ann Koerth Niswanger contributed the family group sheets beginning on 

page 129.  Thanks, Mary Ann. 

 

Ogreta W. Huttash was the Registrar of the William Roark Chapter, Daughters of the Republic 

of Texas (DRT).   I have compiled a list of the members of the William Roark Chapter, DRT 

and their Republic of Texas Ancestors which is printed beginning on page 126.  Mrs. Hutassh’s 

application for membership in the DRT was published in volume 35, Issue 3.  We have re-

ceived permission to print the applications of Georgie Gene Uzzle, Bettye Collier Smith, and 

Mae Gean Pettit and will print them in future issues.  I solicit the help of our readers to obtain 

the addresses of the other DRT members (or their Executors) shown beginning on page 126 to 

obtain permission from them to print their applications. 

 

Making an annual index is a big job requiring help from others.  My thanks to Gene Uzzle, 

Joan Singletary, Helen Marable, Marcella Snow, and Eileen Jones for their help. 

 

 

 

 

 

Gordon Bennett 

 Editor 
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Remembering Margins by Kay Spears 

Eventually, most researchers compiling family histories will want to put their work into a 

printed or electronic “book” for preservation and sharing. Unfortunately, some treat the page 

like an artist’s canvas, and try to fill nearly every inch of space without considering margins. 

The presence of appropriate white space on the page improves appearance and readability, even 

for works that are only distributed in a digital format. In the case of printed works, it would be a 

shame to see your hard work cut off in the trimming process or rendered difficult to read by a 

tight binding, just because of inadequate margins. 

 

Following is a brief review to help you locate margin settings in a variety of programs. 

 

Microsoft Word 2003 and older 

The default side margin setting in Word is 1.25 inches. We recommend a margin of at least one 

inch for all books. The margin settings are located under File>Page Setup>Margins. If the dia-

log box is not displaying margins in inches, you can change the setting by going to 

Tools>Options>General. Find the Measurement Units drop down box at the 

bottom of the page, choose “Inches” and click OK. 

 

Microsoft Word 2007/2010 

Settings are located in the ribbon at Page Layout>Margin. The following options are available: 

Normal (one inch), Narrow, Moderate, Wide, Mirrored, Office Default 2003, and Custom Mar-

gins. The Office Default 2003 option opens up the old margin dialog box. 

 

 

Microsoft Publisher 2003 and older 

The default margin is set at one inch. A word of warning – unlike Word, there is no cursor that 

prevents you from going beyond your margins. Your text is maintained inside a text box that 

can be stretched or shrunk. If you want to change your margin settings in Publisher go to Ar-

range>Layout Guides>Margin Guides. A couple of other 

hints: if you use a professional printing company for publication, make sure they are equipped 

to handle Microsoft Publisher; some are not. Also, when using Publisher take advantage of the 

Guide lines that can be pulled over from the ruler. Just place your cursor on the ruler, hold the 

left click button down and drag. You should see a green line. This guide comes in handy for 

keeping text boxes straight. 

These green lines will not print. 

 

Microsoft Publisher 2007/2010 

A Margin drop down box is in the ribbon, under Page Design. Your choices are Wide (one 

inch), Moderate (default 0.5), Narrow, None, and Custom. 

 



TREE TALK       Volume 35 Issue 4              Summer 2010       Page  112     

 

Remembering Margins  

 

Adobe InDesign 

InDesign is similar to the old Adobe Pagemaker. When you open InDesign, margins probably 

will be measured in “picas” or “p” instead of “inches.” To change the scale to inches, first make 

sure that only the InDesign application is open and not a document. Go to 

Edit>Preferences>Unit & Increments and change to inches. InDesign’s 

margin setting defaults to 0.5 inches, so this will need to be changed. Go to: Layout>Margins 

and Columns and change Top, Bottom, Inside, and Outside. As in Publisher, the cursor will not 

be stopped by the margin; all the text work is done inside of a text box. Also, as in Publisher, 

you may pull the guide lines from the ruler. 

 

Adobe Illustrator 

Normally, Illustrator is used for graphics, posters, flyers, etc. and not for large manuscripts or 

text editing. However, if you want to do something in Illustrator and you need a margin, here is 

a little trick that will help. Go to View>Show Rulers. Now pull guide lines from the rulers into 

the positions where you want to see margins to help you frame your work. 

 

Genealogy Gems:  News from the fort Wayne Library #85, March 31, 2001.  Used by permis-

sion. 
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Benjamin Harrison 23rd President of the United States 
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Benjamin Harrison 23rd President of the United States 
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John Scott Harrison Family 
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William Henry Harrison, 9th President of the United States  
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Benjamin Harrison 
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Benjamin Harrison 
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Benjamin Harrison 
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Benjamin Harrison 
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Benjamin Harrison 
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Richard Harrison 

 

Priscilla Harris 

Haltom 
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Russell Benjamin Harrison Pedigree Chart 
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Benjamin Harrison Pedigree Chart 
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Benjamin Harrison Pedigree Chart 
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Ogreta W. Huttash was the Registrar of the William Roark Chapter, Daughters of the Republic of Texas.  Mrs. 

Huttash’s files are housed in the Genealogy Section of Jacksonville Public Library, 502 S. Jackson, Jacksonville, 

TX 75766.  The following is a list of members compiled by the Editor from the Membership Applications in Mrs. 

Huttash’s file. 

 

LAST FIRST   TX LAST TX FIRST SERVED TEXAS 

Allen Laura Pearl Holcomb Holcomb George Craiger Citizen 

Anderson, Emily Templeton Adams  William  Citizen 

Anderson, Emily Templeton Crysup  William  Citizen 

Arnold Charlotte Bothwell Vining  Rosa Anna Citizen 

Bagley Sherry Ann Moore Koher  George  Citizen 

Banks Inez Watters  Koher  George Craiger Citizen 

Bartels Jessie Amanda (Carroll) Carson  John S.  Citizen 

Bell Shirley Templeton Adams  William  Citizen 

Bolton Mary Ella Meridith Atkinson Alfred  Citizen 

Bolton Mary Ella Meridith Atkinson Elizabeth Jane Housewife 

Bolton Mary Ella Meridith Meredith Daniel Coleman Overseer of public Roads, Juryman, Large 

        Land Owner, Citizen 

Bolton Mary Ella Meridith Smitherman Rebecca  Housewife 

Browning, Carol Ann Schroeder Barksdala Elizabeth (Mrs. Hill) Citizen, Colonist 

Bush Ola Marie Powell  Cates  Lee Isaac Citizen and soldier 

Canter Lucy Marie Kennedy Harris  Robert Thomas Citizen 

Canter Lucy Marie Kennedy McLamore Atkin  Citizen 

Carter Barbara LaNell Pollard Harris  Malinda Jeanette Citizen 

Carter Barbara LaNell Pollard Harris  Sarah  Citizen 

Carter Barbara LaNell Pollard Harris  Emily Arnold Citizen 

Carter Barbara LaNell Pollard Harris  Martha  Citizen 

Carter Barbara LaNell Pollard Harris  Theophilous Citizen 

Carter Barbara LaNell Pollard Harris  Seaborn  Citizen 

Cates Lucille Monk  Anderson Benjamin Citizen, Colonist 

Chapman, Mildred Holland Rushing  Wiliam Riley Citizen 

Christopher, Vada Opal Dell Liles Roark  William  Colonist 

Clements, Betty Jean Craft  Piles, Sr  John   Settler, Land owner and Citizen 

Cole Irma Sue Holland  Holcomb George Craiger Citizen 

Colley Anel Watters  Koher  George  Citizen 

Cooper June Walker  Smitherman Nathaniel W. Soldier 

Daniel Terri Lynn Moore Koher  George  Citizen 

Daniels Ann Marie Hill  Hill  Willlam Carrol Jackson Colonist, soldier 

Darrow Melba Jean  Smith  General Nathanial Soldier 

Dugas Andrea Claire  Roark  Julia Ann Citizen 

Dugas Dreba Raye Thronton Reed  Rev. isaac Minister, teacher and farmer 

Farrell Kahlan Ann Heard Dickson  Mary (Polly) Moore Citizen and Patriot 

Goode Mary Magdelene March Horton  Samuel W. Citizen, farmer 

Gould Sylvia Ann  Smith  General Nathaniel W. Soldier 

Grant Janice Marie Steagold Minchew John M.  Citizen farmer 

Gray Connie Sue Williams Hill  Willlam Carrol Jackson Colonist, Soldier 

Guinn Mearl Amber Wallace Box  John A.  Colonist, land owner and Texas Army 

Gulledge, Golda Deen Collier Roark  William  Colonist, Surveyor, Judge 

Harrison Otha Holcomb  Holcomb George Craiger Citizen 

Heard Lucille Long  Dickson  Mary (Polly) Moore Citizen 

Henderson, Vivian I. Meridith Meredith Daniel Coleman Land owner and citizen 

Hendrick, Annie Thelma Holcomb Holcomb Thomas Harrison Citizen 

 

William Roark Chapter 

Daughters of the Republic of Texas 
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 William Roark Chapter 

Daughters of the Republic of Texas 

LAST FIRST   TX LAST TX FIRST SERVED TEXAS 

 

Hill Donna Faye Worley Reed  Rev. Isaac Minister, teacher and farmer 

Holcomb, Mary Kate Guinn Box  John A.  Colonist, Texas Army and Land Owner 

Huttash Ogreta Wilson  Lee  Isaac  member of Stephen F. Austin's colony 

Huttash Ogreta Wilson  Lee  Mrs. Patsy member of Stephen F. Austin's colony 

Jennings Gloria Bonita Guinn Box  John A.  Colonist, Texas Army and Land Owner 

Johnson Helen Virginia Durham Haralson James Carroll Citizen 

Johnson Willie Lee Monk  Lee  Isaac  Citizen and soldier 

Kelly Roselyn Tightman Mallard  Edlridge  Member of Mercer colony, headright in 

        Ellis Co. Patent No. 806 Vol.10 

Kennedy Guynell Watters Koher  Elias Myers Citizen 

Kennedy Guynell Watters Myers  Susanna  Citizen 

Killingsworth Darlene Smith Eubank  Elias M.  Colonist, loyal citizen 

Killingsworth Darlene Smith Eubank  Elizabeth Wills Loyal Citizen, wife of a colonist &soldier 

Killingsworth Darlene Smith McFarland William  Citizen, Surveyor, Alcalde of San  

        Augustine and Judge 

Killingsworth Darlene Smith McFarland Thomas Stuart Aide, Soldier, Lt. colonel 

Killingsworth Darlene Smith Thompson Elizabeth W. Loyal Citizen, wife of a colonist 

Lazarine Maggie Charlene McKeown  Johnson Cave  Citizen 

Linney Catherine Jane Meredith Atkinson Elizabeth Jane arrived in Texas in 1837 

Linney Catherine Jane Meredith Atkinson Alfred  Citizen and land owner 

Linney Catherine Jane Meredith Meredith Daniel Coleman Citizen and large land owner 

Linney Catherine Jane Meredith Smitherman Rebecca  Housewife who reared a large family 

Lunsford, Mary Bessie Rodgers McGuire Hamilton Bishop physician 

Mallard Marion Elizabeth  Mallard Eldridge Thornton Citizen 

March Bill Allen  Horton  Sarah Frances Colonist 

March Bill Allen  Horton  Isabella Weeks Colonist 

March Bill Allen  Horton  Susannah Purnell Colonist 

March Bill Allen  Horton  Samuel W. Colonist, farmer 

Martin Ona Faye Acker  Walling  Martha Hamlett Citizen 

Martin Ona Faye Acker  Walling  John  Citizen 

Martin Ona Faye Acker  Walling  James   colonist who furnished supplies to the 

        Army 

Mayall Dixie Lee Guinn  Box  John A.  Colonist, Texas Army and Land Owner 

McCarty Sally Suzann  Bloomfield Mary Jane Citizen 

McCarty Sally Suzann  Frazer  Melvina H. Citizen 

McCarty Sally Suzann  Frazer  John William Citizen 

McClendon, Gladys Eliza Durham Haralson James Carroll Citizen 

Mehner Kathryn Marie  Frazer  John William Citizen 

Miller Mary Joyce Sloan Mallard Eldridge Thornton Settler in Mercer Colony and citizen 

Mims Nancy Jane Guinn Box  John A.  Colonist, Texas Army and Land Owner 

Moore Alene Watters  Koher  George  Citizen 

Moore Shannon Lee  Koher  George  Citizen 

Nicar Annie Ruth Hendrick Hendrick Henry Clay Citizen 

Perrin Barbara Bolton  Meredith Daniel Coleman Citizen 

Pettit Mae Gean McElroy Dickey  Moses  Citizen 

Pettit Mae Gean McElroy Dickey  Melvina D. Citizen 

Pettit Mae Gean McElroy Dickey Robert James (Bob) Citizen 

Pettit Mae Gean McElroy James  Lydia  Citizen 

Pettit Mae Gean McElroy Langston Jacob  Citizen 

Pettit Mae Gean McElroy Langston Lydia  Citizen 
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William Roark Chapter 

Daughters of the Republic of Texas 

LAST FIRST   TX LAST TX FIRST SERVED TEXAS 

 

Pettit Mae Gean McElroy Langston Rebecca  Citizen 

Roberts Ethel Odelia Russell Carson  John S.  Citizen 

Rogers Katherine Louise  Smith  General Nathaniel Soldier 

Rogers Lou McFarland  Eubank  Elias M.  Colonist, Loyal Citizen 

Rogers Lou McFarland  Eubank  Elizabeth Wills Loyal Citizen, wife of Colonist and Soldier 

Rogers Lou McFarland  McFarland Thomas Stuart Aide, Soldier, Lt. Colonel 

Rogers Lou McFarland  McFarland William  Citizen, Surveyor, Alcalde of San  

        Augustine and Judge 

Rogers Lou McFarland  Thompson Elizabeth Wills Wife of Colonist and loyal citizen 

Rose Edith Crosby  Chambliss Nancy  Citizen 

Rose Edith Crosby  Harper  Elizabeth Citizen 

Rose Edith Crosby  Reed  Rev. Isaac Minister, teacher and farmer 

Rose Edith Crosby  Roark  Willaim  Surveyor and was granted a headright in 

        Nacogdoches County. 

Rose Edith Crosby  Roark  John  Citizen, farmer 

Rozella Alene Watters Moore Koher  Elias M.  Citizen 

Rozella Alene Watters Moore Myers  Susanna  Citizen 

Rudloff Doris Rodgers Alford McGuire Hamilton Bishop Physician 

Russell Frances LaNell Burt Newman Felix P.  Citizen 

Russell  Gaston  Mathew   Alexander  

Schroeder Della Ann Hill Hill  Asa  Citizen, Colonist 

Schroeder Susan Kay Hill  William Carrol Jackson Colonist, Soldier 

Sides Lydia Leona Harper Newman Truman L. Citizen 

Smith Bettye Jo Collier  Collier  Isabel Yancy Kimbrough Citizen 

Smith Bettye Jo Collier  Keith  John  Hinton Citizen 

Smith Edna Holcomb  Holcomb George Craiger Citizen 

Smith Ruby Kae McFarland McFarland Thomas Stuart Aide, Soldier, Lt. Colonel 

Thompson, Rosemary Holcomb Hendrick Dr. Edwin Volunteer in the Texas Revolution 

Thornton, Thelma Oleta Jackson Jackson  Peter  Citizen 

Thornton, Mary Edna McQuistion Roark  Julia Ann Citizen 

Uzzle Georgie Gene Watters Koher  George  Citizen 

Wesley Delbra Ballard  Smith  General Nathaniel W. Citizen 

Wilcox Dorothy LaNelle  Jenkins  Greenberry Citizen 

Williams, Donna Zane Frasier Prather  Stephen  Colonist, in Fredonia Rebellion 

Williams, Jacquelyn Hill  Hill  William Carrol Jackson Colonist, Soldier 

Wood Kathryn Hart  Davis  Joseph Alexander Citizen 

Worley Reba Ellen Thornton Reed  Rev. Isaac Minister, Teacher and Farmer 

Yeates Clara Belle McQuistion Roark  William  Citizen 

    Roark  William  

 

From the Archives of Ogreta W. Huttash in the Genealogy Section of the Jacksonville, Texas Public Library , 

Catalog number 929.3764 HU 136 in the name of DRT-Daughters of the Republic of Texas. 
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 Elisha & Nancy Sheldon Family 
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Joseph and Elizabeth Land (or Lann) 
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 Jacob Girbon (or Girhan) and Omega Williams Family 
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Publications available through CHEROKEE COUNTY GENEALOGICAL SOCIETY 

  P.O. Box 1332, Jacksonville, Texas 75766-1332 

 

___1850 CHEROKEE CO. FED. CENSUS & MORTALITY SCHEDULE, by Sue Taylor, 76 pgs, (1986)indexed  
 ISBN 1-931167-05-2          $10.00 

___1860 CHEROKEE CO. FED CENSUS & SLAVE SCHEDULE, 131 pgs, indexed. ISBN 1-931167-06-0   $11.00 

___1870 Cherokee County Federal Census, Agricultural Schedule, Mortality Schedule and Tax Rolls, by Sue Vaughn Taylor and Ira Gaylon  
 White, 150 pages  (1999) indexed  ISBN 1-931167-07-9      $11.00 

___1880 CHEROKEE CO. FED. CENSUS, by Sue Taylor, 504 pgs. plus pgs of column explanations & abbreviation explanations:  

 other introductory pgs., (1983) indexed. ISBN 1-931167-09-7         $38.00 
___1910 CHEROKEE CO. FED. CENSUS, by Bobbie Berry Dowling & Ira Gaylon White, 265 pgs, plus 3 pgs of column explanations,  

 (1998), indexed   ISBN 1-931167-09-5         $24.00 

___AN ALBUM OF CHEROKEE COUNTY, TX MEN & WOMEN WHO SERVED IN WW 11, THE KOREAN CONFLICT OR  
 VIET NAM (1994), n avy with white imprint, red tape binder, 260 pgs., softbound, indexed. ISBN 1-931167-00-1 $21.00 

 

___Cemeteries of NW Cherokee County by Helen Wooddell Crawford Book 1     $10.00 
___Cemeteries of Jacksonville, and others by Helen Wooddell Crawford Book 2     $  8.00 

___Cemeteries of NE Cherokee County by Helen Wooddell Crawford Book 3     $11.00 

___Cemeteries of Mid Cherokee County by Helen Wooddell Crawford Book 4           $10.00 

___Cemeteries of Southern Cherokee County by Helen Wooddell Crawford Book 5     $  8.00 

___CHEROKEE COUNTY DEATH RECORDS, 1903-1945, by IdaLee D. Edmiston (1998) 351 pgs., softbound, approximately  

 alphabetical ISBN 1-931167-10-9        $31.00 
___Church Book for Church of Christ at Salem Edgefield District South Carolina To Sardis Baptist Church at Cherokee County, Texas A.D. 

 1836- A.D. 1941: copy of original handwritten minutes, names of members, pastors; 260 letter-size pages, softbound, 3rd  

 edition, (2006) indexed by Sue Taylor & Bobbie Dowling ISBN 1-931167-15-X  LCCN 2006928721  $22.00 
___CHURCH BOOK OF PLEASANT GROVE BAPTIST CHURCH CHEROKEE CO., TX. VOL. 1, Sep. 1854 to Feb. 1921. Copy of  

 original handwritten minutes of the church, names of pastors, roster of members, obituary notices on some members,  
 introductory pages includes a brief history of the church, surrounding area, and map of location, 452 pgs, (1992), softbound,  

 indexed. ISBN 1-931167-O1-X          $39.00 

___CHURCH BOOK OF PLEASANT GROVE BAPTIST CHURCH, CHEROKEE CO., TX. VOL. II, Mar. 1921 to Apr. 1961. Copy  
 of original handwritten minutes of the church, names of pastors, roster of members, obituary notices on some members,  

 (Introductory pgs. the same as VOL. I above), 500 pgs, softbound, indexed ISBN 1-931167-02-8   $40.00 

___CHURCH BOOK OF ROCKY SPRINGS MISSIONARY BAPTIST CHURCH, CHEROKEE CO., TX 1871-1912, copy of original  
 handwritten minutes, names of pastors, roster of members, 351 pgs, softbound, (1991) indexed by IdaLee Derrett Edmiston  

 ISBN 1-931167-03-6           $28.00 

___CIVIL WAR RECORDS OF CHEROKEE CO., TX, VOL. 1. by Ogreta W. Huttash, 93 pgs, (1982). Most complete list from  
 soldiers from Cherokee county available, plus interesting documents from individuals, softbound, indexed.  $14.00 

___CIVIL WAR RECORDS OF CHEROKEE CO., TX, VOL. 11, PENSIONS. by Ogreta W. Huttash, 115 pgs, (1982). Summary of  

 over 700 pension applications by veterans & widows who lived in Cherokee County, softbound, indexed.  $15.00  
___COMMISSIONERS COURT MINUTES, No. 1, Cherokee co., TX, 12 Oct. 1846 through a called session 4 Feb. 1850. A verbatim  

 copy which  lists the  first 37 land certificates, precincts and their boundaries, patrol captain, road workers, overseers,  

 prisoners, etc. 86 pgs, by Ogreta W.  Huttash, (I 989) softbound, indexed     $12.00 
___Early probates & wills of Cherokee County, compiled from the original papers by Helen Wooddell Crawford ISBN  978-1-931167-47-5 

            $20.00 

___Federal Census of Cherokee County, 1870 by Helen Crawford, 154 pages (1983) plus surname index.    $10.00 
___FIRST RECORDED MINUTES OF THE DISTRICT COURT OF CHEROKEE CO., TX A verbatim copy of the original book in  

 the office of the  Dist. clerk, Rusk, TX Oct. 1846 through Nov. 1848, by Ogreta W. Huttash, 112 pgs, (1987), softbound,  

 indexed           $12.00 
___GRAVE MARKER INDEX FOR CHEROKEE COUNTY TEXAS, (2000), by Ira Gaylon White, edited by Gordon Bennett. An  

 alphabetical listing of 29,484 markers from 15 published sources. 476 pgs., softbound, ISBN 0-9703085-7-4  $25.00 

___GRAVE MARKER INDEX FOR CHEROKEE COUNTY TEXAS, (2000), by Ira Gaylon White, edited by Gordon Bennett. An  
 alphabetical listing of 29,484 markers from 15 published sources. 1 CD-ROM, ISBN 1-931167-12-5   $15.00 

___HISTORICAL MARKERS OF CHEROKEE COUNTY, TX. by Ogreta W. Huttash. Contains inscriptions on the 103 state  

 approved markers erected before 1995. 2000 edition, full name index.     $12.00 
 $30.00 

___Index to TREE TALK, May 1980 through December 1990, compiled by Sylvia Booth Acker and Ira Gaylon White, edited by  

 Gordon Bennett (2004), 146 pgs., softbound, ISBN 1-931167-33-8, LCCN 2004104368    $12.00  

___Larissa College 1857-1860  (This material is a compiled book of articles printed of Larissa College, and in 1915 it was said that  

 this was the only material on the college. It has the names  of the Board, teachers, visitors & children.)  

 by Helen Crawford          $  7.00 
 

___Marriage Records of Cherokee County Texas 1905-1931 (2001) by Sylvia Booth Acker, Melva Hermes, and Ira Gaylon White.  

 Edited  by Gordon Bennett. A listing of 8,192 marriages 262 pgs., softbound, ISBN 1-931167-14-1   $17.00 
___Marriage Records of Cherokee County Texas 1905-1931 (2001) by Sylvia Booth Acker, Melva Hermes, and Ira Gaylon White.  

 Edited   by Gordon Bennett. A listing of 8,192 marriages. 1 CD-ROM, ISBN 1-931167-16-8   $15.00 

___MARRIAGE RECORDS OF CHEROKEE CO., TX, 1846-1880, VOL. 1. by Ogreta W. Huttash. 100 pgs, copyright 1974, fifth Printing,  
 1985,  Approximately 4,000 marriages alphabetically by name of groom: full-name index of brides.  $14.00 

___MARRIAGE RECORDS OF CHEROKEE CO., TX, 1881-1905, VOL. 11. by Ogreta W. Huttash. 127 pgs, copyright 1976,  

 Approximately   5800 marriages alphabetically by name of groom: full-name index of brides.   $17.00 
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___National Tomato Capital 305 pgs Tomato history in Cherokee County by Helen Wooddell Crawford   $29.00 
___Newspaper Obituaries from early papers 1889-1908   Bk.1 166 pgs by Helen Wooddell Crawford ISBN 1-931167-18-4  $16.00 

___Newspaper Obits 1910-1921,  Bk 2  309 pgs by Helen Wooddell Crawford    ISBN 1-931167-29-X    $25.00 

___Newspaper Obits assorted dates Bk 3 260 pgs by Helen Wooddell Crawford ISBN 1-931167-30-3  $20.00 
___Newspaper Obits   Bk.4  469 pgs by Helen Wooddell Crawford ISBN 1-931167-31-1  $44.00 

___Newspaper Obits   Bk 5 495 pgs by Helen Wooddell Crawford ISBN 1-931167-32-X  $25.00 

___Newspaper Obits 1922-1925  Bk 6 182 pgs by Helen Wooddell Crawford ISBN  978-1-931167-25-3 $16.00 
___Newspaper Obits assorted dates Bk 7 368 pgs by Helen Wooddell Crawford  ISBN  978-1-931167-50-5 $29.00 

___Newspaper Obits  1991 & part of 1990   Bk 8  256 pgs  by Helen Wooddell Crawford  ISBN 978-1-931167-49-9 $20.00 

___Newspaper Obits  1992  Bk 9  194 pgs by Helen Wooddell Crawford ISBN 978-1-931167-51-2 $18.00 
___Newspaper Obits  1993 Bk 10 209 pgs  by Helen Wooddell Crawford  ISBN 1-931167-23-0  $16.00 

___Newspaper Obits  1994 Bk 11 206 pgs  by Helen Wooddell Crawford  ISBN 1-931167-22-2  $16.00 

___Newspaper Obits 1995 Bk 12 205 pgs  by Helen Wooddell Crawford    ISBN  978-1-931167-43-7 $16.00 
___Newspaper Obits  1996 Bk 13 226 pgs  by Helen Wooddell Crawford    ISBN 1-931167-21-4  $18.00 

___Newspaper Obits 1997 Bk 14 197   pgs by Helen Wooddell Crawford   ISBN 1-931167-20-6   $16.00 

___Newspaper Obits  1998 Bk 15 205 pgs by Helen Wooddell Crawford ISBN 978-1-931167-39-0 $16.00 
___Newspaper Obits 1999 Bk 16  196 pgs  by Helen Wooddell Crawford  ISBN 1-931167-19-2  $16.00 

___Newspaper Obits  2000 Bk 17  215 pgs by Helen Wooddell Crawford    ISBN 1-931167-40-0  $17.00 

___Newspaper Obits  2001 Bk 18 221 pgs  by Helen Wooddell Crawford , soft cover, Indexed ISBN 1-931167-13-3  $19.00 
___Newspaper Obits  1926-1931  Bk 19 177 pgs  by Helen Wooddell Crawford  ISBN 1-931167-17-6  $16.00 

 

     
 ___Newspaper Obituaries Index of Cherokee County, Texas 1836-2001  BOOKS  1-19       by Helen Wooddell Crawford   

 ISBN 1-931167-36-2                $22.00 

___Newspaper Obituaries Index of Cherokee County, Texas 1836-2001  BOOKS  1-19 CD-ROM      by Helen Wooddell Crawford   
 ISBN 1-931167-37-0,          $15.00 

___NORTHWEST CHEROKEE CO. CEMETERIES, VOL. 1, 20 cemeteries (1997), by Ira Gaylon White, 253 pgs, softbound, indexed  
 ISBN 0-9703095-8-2          $35.00 

___NORTHWEST CHEROKEE CO. CEMETERIES, VOL. II 25 cemeteries (1997), by Ira Gaylon White, 288 pgs, softbound, indexed  

 ISBN 0-9703085-9-0          $40.00 
___OUR BEFORES - ANCESTOR CHARTS, VOL. 1, 250 pgs., (1982), indexed ISBN 0-9703085-1-5   $18.00 

___OUR BEFORES - ANCESTOR CHARTS, VOL. 2, 252 pgs., (1982), indexed ISBN 0-9703085-2-3   $16.00 

___OUR BEFORES - ANCESTOR CHARTS, VOL. 3, 176 pgs., (1986), indexed ISBN 0-9703085-3-1   $13.00 
___OUR BEFORES - ANCESTOR CHARTS, VOL. 4, 222 pgs., (1991), indexed ISBN 0-9703085-4-X   $16.00 

___OUR BEFORES - ANCESTOR CHARTS, VOL. 5, 247 pgs., (1996), indexed ISBN 0-9703085-5-8   $17.00 

___OUR BEFORES - ANCESTOR CHARTS, VOL. 6, 168 pgs. (2000), indexed. ISBN 0-9703085-6-6   $16.00 

___PROBATE RECORDS OF CHEROKEE COUNTY, TX, MINUTE BOOK A, 1870-1881 and DOCKET A and DOCKET B.,  

                  1867-1887 by Ogreta W. Huttash, 125 pages (2004), Softbound, Indexed.     $20.00 

___PROBATE RECORDS OF CHEROKEE COUNTY, TX 1846- ca 1875 by Ogreta W. Huttash, 200 pages (1998) Includes estates,  
 settlements,  guardianships for minors, community property of decedents, heirs, and the name of the surviving spouse. Slaves  

                  in estate settlements are indexed under the name of the owner. Softbound, indexed    $29.00 

___Providence Cemetery Cherokee County Texas  by Sylvia Booth Acker and Willie Harold Acker, Sr., ISBN 978-1-931167-42-0 
                   LCCN 2011909068                                                                                                   $12.00 

___Saga of Cherokee County, Texas. Book  1 indexed 417 pgs by Helen Wooddell Crawford  ISBN 1-931167-26-5   $33.00 

___Saga of Cherokee Book 2  1910-1921 indexed  491 pgs by Helen Wooddell Crawford ISBN 1-931167-24-9  $34.00 
___Saga of Cherokee,   Book 3 ass'td dates, indexed 433 pgs by Helen Wooddell Crawford $30.00 

___Saga of Cherokee Book 4 1922-1925, indexed  504 pgs by Helen Wooddell Crawford  ISBN 978-1-931167-48-2  $34.00 

___Saga of Cherokee Book  5, ass'td dates, indexed 471 pgs by Helen Wooddell Crawford  ISBN-10 1-931167-34-6    $45.00 
___Saga of Cherokee and World War I,  Book  6 indexed 256  pgs by Helen Wooddell Crawford $28.00 

___Saga of Cherokee County and Pioneer Life Book 7, indexed,  167 pgs, by Helen Wooddell Crawford ISBN 1-931167-28-1  $18.00 

 
___TREE TALK, THE FIRST FIVE YEARS, May 12,1975 through April 30,1980. Contains a brief history of the organization of the  

 Cherokee  County Genealogical Society,  charter membership roster, etc.. (1995), full name index (1998)  

 ISBN 1-931167-11-7          $11.00 
___Tree Talk, Volume I through Vol. 25, No. 3. (2000) Contains the complete text (about 3600 pages) of the 25 years of this  

 publication. 2 CD-ROMs. ISBN 0-9703085-0-7, ISSN 1551-0514, LCCN 2004204271     $30.00 

___Tyler Courier-Times-Telegraph 1950  Mid Century Edition.  275 pgs by Helen Wooddell Crawford   $24.00 
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Order Form 

This form may be used when ordering books from CCGS. Include .0825 tax (for TX residents only) on each 

item in the catalog. Also POSTAGE & HANDLING CHARGE of $3.50 for the first book plus $1.00 for each 

additional book ordered at the same time. List the book or books you wish to order and show the total amount be-

low. 

 

 Your Name:______________________________________________________________________ 

    

Address: ____________________________________________E-Mail___________________________ 

 (Street address or P.O. Box) 

____________________________________________________________________________________ 

(city or town)     (state)    (9-digit Zip code) 

 

 Total amount of order   $___________________________ 

 

 State sales Tax 

(if applicable)    $___________________________ 

 

 Postage & Handling   $___________________________ 

 

 TOTAL ENCLOSED   $___________________________ 

 

 Mail to:  Cherokee County Genealogical Sciety 

  P.O. Box 1332 

  Jacksonville, TX 75766-1332 

Quantity Title Price Extended 

Price 
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Membership Application 
 

  CHEROKEE COUNTY 

 

  GENEALOGICAL SOCIETY 

 

  Post Office Box 1332 

 

  Jacksonville, Texas 75766-1332 

 

  Annual membership dues are $15.00 (single) and $20.00 for a two-member household. The membership year 

ends August 31, 2011. Membership entitles you to four quarterly issues of our publication Tree Talk. Tree Talk is 

normally published the first week of October, January, April and July of each fiscal year. Members joining after 

the first issue is published will receive all issues of Tree Talk, but back issues of Tree Talk will be mailed with the 

next issue unless $1.00 for special handling is enclosed. The Society meets the second Monday of the months Sep-

tember through May at Bonner Place, 421 S. Bonner, Jacksonville, Texas at 7 p.m. 

 

  Date of Application ______________________________ Paid through 8/31/______________ 

 

  Single Membership $15.00________________  New Member____________________ 

 

   

 Two-Member household $20.00____________  Renewal________________________ 

 

   

 Name:__________________________________________________________________________ 

 

   

 Address:________________________________________________________________________ 

 

   

 City:_______________________ State:________________ 9-digit Zip Code___________________ 

 

   

 Phone Number (include area code):____________________ E-mail Address____________________ 

 

   

 Maiden Name (if applicable)__________________________________________________________ 

 

   

 Surnames you are researching;________________________________________________________ 

 

  _______________________________________________________________________________ 

 

Gift of _____________________________, bill to: _________________________________________   

 Complete the information above, make out your check, and mail to:  

 

   Cherokee County Genealogical Society  

  

 Post Office Box 1332 

 

            Jacksonville, Texas 75766-1332 
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